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1 Introduction 
The software, 3D DataManager, consists of two modules. The first, 3D DataManager 
Extractor, is designed to export a SmartPlant 3D database into a Microsoft Access 
file, containing one table per task. The resulting records are compressed and internally 
resolved by code lists. The Access file serves as a base for the second module, the 3D 
DataManager user interface, used to create Reports with simple drag ’n drop opera-
tions. 

Additionally, 3D DataManager is divided into two versions. The 3D DataManager 
Reporter utility is primarily used for reporting, while the other version, the 3D Data-
Manager Pro Extends the Reporter version with the ability to change Data and write 
the changes back to Intergraph’s SmartPlant® 3D 

 

1.1 General Conventions 
This document contains many visual cues to help you understand the meaning of certain 
words or phrases. The use of different fonts for different types of information allows 
you to scan the document for key concepts or commands. Symbols help abbreviate and 
identify commonly used words, phrases, or groups of related information 

1.2 Typefaces 
Italic Indicates a system response, which is an explanation of 

what the software is doing. For example,  
 
The text is placed in the viewing plane. 

Bold Indicates a command name, parameter name, or dialog 
box title. Command paths are shown using an arrow be-
tween command names. For example, 

 Choose File > Open to load a new file. 

Sans serif Indicates a system prompt or message, which requires an 
action be taken by the user. For example,  
 
Select first segment of alignment 

Normal typewriter 
Indicates an actual file or directory name. For example,  
 
The ASCII report is stored in the layout.rpt file. 

Bold typewriter 
Indicates what you literally type in. For example,  
 
Key in original.dat to load the ASCII file. 
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1.3 Symbols 
This document uses the following symbols to identify special information: 

 Note – important supplemental information. 

 

 Map or path – shows you how to get to a specific command or form. 

 

 More information – indicates there is additional or related information. 
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2 Installation 
Requirements: 

• Operating system: Windows 2000 SP4/XP/2003/Vista 

• Intergraph SmartPlant 3D SP4 (7.0.0.44.10) or later 

• Microsoft Excel 2000 or later (only for 3D DataManager Reporter) 

4 



License   

3 License 
There are two different licenses: 

• 3D DataManager Reporter: used to extract SmartPlant 3D plant into 
access in order to make reports 

• 3D DataManager Pro: Extends the 3D DataManager Reporter features 
as listed above, and enables the write changes function, which transfers 
changes made to values in the interface back into SmartPlant 3D 

Once the setup has been completed, and the program is started, a license key will be re-
quested, as shown below. 

 

 Note: Without a valid license the software works in demo mode. 

 Note: As seen above the domain name is required in order to generate a 
license key. 3D DataManager can then be used with the same license key 
on all computers in the same domain. 

If the installed license needs to be updated (i.e. evaluation license) select Update li-
cense… from the Help menu. The dialog box shown above will be displayed again. 
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4 3D DataManager Extractor 
 Note: 3D DataManager Extractor requires SmartPlant 3D and a Smart-

Plant 3D (S3D) license seat on a SmartPlant License Server. 

The 3D DataManager Extractor is used to extract SmartPlant 3D data out of an ex-
isting project. Since the extractor uses the SmartPlant 3D API, it requires SmartPlant 
3D and a SmartPlant 3D License seat (S3D) on a SmartPlant License server. Using 
the API enables the extractor to be installed and used without dealing with any issues 
from the Database. 

4.1 Loading and Setting up a SmartPlant 3D Plant 
Use the Plant combo box to select a SmartPlant 3D plant. 

 

After selecting a Plant, the available Tasks and the associated filters are displayed in the 
Tasks section. Use the tree in the filter section to apply a filter to the selected task. 

 Note: Applying the filter will speed up the extraction process 

 

The Equipment-, Piping-, Electrical-, HVAC- and Structural-tasks includes all task-
specific data from the plant. The available filters are defined via SmartPlant 3D. 
If checked, the catalog task will extract all the Piping specific data from the catalog to 
the specified database, during the extraction.  

 

 Note: For each task individual filters can be applied. 
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 Note: Extracting the Catalog with all available specs selected may 
lengthen the extraction duration. Keep the Pipe Specs selection to a bare 
minimum in order to shorten the extraction time 

Browse with the ( ) button to create a Microsoft Access Database file where the re-
sults will be created. 

 

Force extraction – By default the software processes only changed objects since the 
last extraction when the switch is disabled (recommended).The data of the last extrac-
tion is stored in *.3dm file which is password protected and located in the same direc-
tory as result access database. If the *.3dm file doesn’t exist or the force extraction 
switch is enabled, all objects will be extracted from SmartPlant 3D this can require a 
large amount of time. 

Create SmartPlant Review session- See Create SmartPlant Review session

All the settings are stored automatically in the configuration file which is found under 
Tools>Settings. 

Start the process by clicking the Extract button. 

 Note: The progress bar displayed at the bottom right hand side of the 
window does not display the true progress. It displays the progress for each 
object in SmartPlant 3D. due to this it will load multiple times. 

4.2 Create SmartPlant Review session 
3D DataManager Extractor allows creation of a Design Review session which can be 
viewed in 3D DataManager or in SmartPlant Review.  

If the checkbox Create SmartPlant Review session is enabled the software creates 
SmartPlant Review *.vue file containing the graphical objects from selected tasks (ac-
cording to the applied filter) and the SmartPlant Review database (*.mdb2) with at-
tributes as configured in the “Configure attributes” menu  

 Note: *.vue file can be opened in SmartPlant Review 6.2 or higher.  

 Note: The *.xml file containing attributes for SmartPlant Review ses-
sions, which is typically created upon creation of a SmartPlant Review in 
SmartPlant 3D, is not required and not generated, because all attributes for 
the objects inside of the *.vue file is stored directly in the SmartPlant Re-
view database (*.mdb2). 
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4.3 Configure Search Filters 
The search filters menu allows defining SmartPlant 3D filters which will be used to 
check if they contain any of extracted objects. As result the software creates a table 
named “Object Filters” in resulting access database which has the following format: 

Item Name Filter Name 

Concentric Size Change-0001 Complete Plant 

Concentric Size Change-0001 Area1 

Tee-0001 Complete Plant 

 

 Note: The table shown above demonstrates a concept only. The resulting 
database contains the object OID column instead of the Item Name. Any of 
the attributes for the corresponding object can be queried by joining the 
“Object Filters” with the proper table (e.g. “Piping” or “Equipment”). 

 Note: Selecting many search filters may cause low extraction perform-
ance. 

4.4 Configure Columns/Attributes 
The ability to configure attributes is specifically made in order to configure and add user 
attributes to the next extraction. 

The appearance of the columns in the resulting database can be configured by selecting 
Configure attributes… from the Tools menu. The following dialog will be shown: 
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The tree on the right hand side shows the configured columns in a specific task (table). 
The Objects listed on the left hand side are used as references for the column mapping 
which is done on the right hand side.  

Mapping one or more objects to columns can be done by dragging and dropping a se-
lected object in to the target column. 

If you expand the column node in the right tree, you will see the object variants, the 
column cells can contain. 

 

In the last expansion level the attribute name is listed as shown below. 

 

Different attributes can be mapped to a single column as shown above. The attribute that 
fits to the object type in the current row will be shown. A single column can be removed 
or renamed by selecting the necessary option in the context menu which is opened by 
right clicking on a node. The attributes which belong to an object type are listed by ex-
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panding the relative object type node. Dragging a single attribute node and dropping it 
on the (task/table) main node on the right side will map the object to the column. 

 Note: The changes will be applied on the next extraction 

4.5 Configure Units of Measure 
Select Configure Units … from the Tools menu to customize the UoM (Units of Meas-
ure) settings for the result database. The units of measure are taken for SmartPlant 3D. 
They directly affect the results of the extraction, since each value is calculated using the 
set unit type in the grid. For example, a length of a 1000 mm would display 1m in the 
result database if the distance Unit Type is set to meters. 

 

• Unit Type – Unit of Measure description 

• Unit – Measuring unit abbreviation 

• Decimal Precision – Decimal precision to format the value (decimal 
count) 

• Leading Zero – Enable leading zero to format the value 

• Trailing Zeros –Enable trailing zeros to format the value 

 Note: The changes will be applied on the next extraction 

4.6 Result database 
The software creates separate tables, with one row per object, for each selected task. 
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Sample reports and queries are also included in the created Access file. 

 

Piping Catalog 
The table contains the following objects: 

• PipingCommodityFilter 

• BoltSelectionFilter 

• GasketSelectionFilter 

• NutSelectionFilter 

• WasherSelectionFilter 

Piping 
The table contains the following objects: 

• Pipe Part 

• Pipe Component 

• Implied Part Occurrence 

• Pipe Instrument 
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• Pipe Specialty Item 

• Pipe Bolt Set 

• Pipe Weld 

• Pipe Gasket 

• Pipe Supports 

 Note: The length, surface area and Volume are estimated values that are calculated using ba-
sic mathematical formulas. These values are only estimates and should only be used as a 
reference. 

Equipment 
The Equipment table contains one row for each nozzle and one additional row for each 
Equipment/Equipment Component without any nozzles as shown below: 

Equipment Equipment Component Nozzle 

Pump  N1 

Pump  N2 

Tank Ladder  

Tank Platform  

Tank  N1 

Tank  N2 

Tank  N3 

Loudspeaker   

 

The table contains the following objects: 

• Equipment 

• Equipment Component 

• Pipe Nozzle 

Structural 
The table contains the following objects: 

• Member Part Prismatic 

• Member Part Curve 

• Ladder 

Stair • 

12 



3D DataManager Extractor   

• Handrail 

 Connection 

HVAC 
The table contains the following object: 

Electrical 
able contains the following objects: 

Plant 
The table includes the information about the plant and database. 

4.7 
 can be use in to ways. The conventional way, which 

has been described up to this point, and a somewhat less conventional way, using a 

ow is done by clicking the windows start menu, and select-
ing the run item. Then enter cmd into the text box. This will open the prompt. 

stallation 
path of 3D DataManager followed by “\3D DataManager Extractor.exe” 

• Assembly

• Footing Component 

• Slab 

• Duct Component 

The t

• Cable Tray Component 

• Cable Tray Part 

• Cableway 

Batch Mode 
The 3D DataManager Extractor

command line as seen below. This function can be used to help automate the exportation 
of a SmartPlant 3D Plant. 

Opening the command wind

To then open the 3D DataManager Extractor batch mode help type in the in

/?. 

 

 

There are two parameters for the 3D DataManager Extractor. The first is the Smart-
Plant 3D plant name. The other is a configuration file which contains the settings for 
the extraction. If a configuration file is not defined, the last selected configuration will 
be used. 
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5 3D DataManager Reporter 
3D DataManager creates queries and easy-to-customize reports based on the Access 
file which contains the SmartPlant 3D data, exported using 3D DataManager Extrac-
tor. The user interface is made in such a way that simple drag ’n drop operations can 
quickly create, save and export custom reports. On top of all the listed functions, the 3D 
DataManager Pro version additionally allows changes to the data in SmartPlant 3D. 

5.1 A Brief Overview 
 The Reporter window is separated into four sections as follows:  

 
Parts of 3D DataManager 

 Note: All sections can be resized and the visibility can be toggled. To 

show or hide a single section use the appropriate buttons ( ), re-

size can be done by moving the bars between the sec ( ) and/or by resizing 
the window. 

Elements 
As seen in the figure under A Brief Overview, 3D DataManager consists of three main 
parts. Each part performs its on specific function in order to give the best control over 
3D DataManager. The following sections describe the each part and function briefly. 
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Tree Filter 

Nodes of the tree view 

The Tree Filter is a visualisation of the SmartPlant 3D Database, exported with 3D 
DataManager Extractor to an Access Database (see: Working with 3D DataManager 
Extractor). Each node listed in the Tree Filter is either a table, column or value repre-
sented in the Access Database, which in retrospect refer to a task, attribute or value in 
SmartPlant 3D.  

As seen in the above figure, the base nodes are always Task nodes. These Nodes repre-
sent each table in the Access Databank, and can be added, or removed with the Tree 
Manager (see Tree Manager). Task nodes cannot be renamed. 

The second node types visible are the Attribute nodes. These nodes can be differentiated 
from the value nodes by bold text and from the task nodes by position. Attribute nodes 
are always at the even positions in the tree path. Unlike Value nodes and Table nodes, 
these nodes can be renamed (see Context Menus). 

The last type of nodes listed in the figure are Value nodes. These represent each possible 
value for an attribute, and are used as a filter and grouping mechanism for a View (see 
Grouping Tree Elements). 
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Report Attributes 

 

Attribute Statuses 

The Report Attributes lists all available attributes for the selected task in the Tree Fil-
ter (see Tree Filter). Checking or un-checking an attribute adds/removes a column to the 
Report Grid (see Report Grid and Arranging Views) while checking Operators adds 

COUNT – displays the number of unique values of the parent attribute for each row in 
the Report Grid. This operation cannot be selected with its corresponding attribute. 

Attributes are divided into three types, numeric and date, non-numeric, and Path Attrib-
utes. The operators that are allowed are for each attribute is determined by the type of 
attribute. Numeric attributes have all Operators unless the attribute is also in the path, 
then it only has a sum. Non-numeric attributes only enable COUNT operations. Attrib-
utes with checked operators are shown in bold print. 

Path Attributes are shown in italics. They refer to attributes that are in the current path 
of the selected node in the Tree Filter, and are used to group and/or filter in the Report 
Grid. Path Attributes cannot be un-checked, instead have to be unselected in the Tree 
Filter. 

columns that have influence on its related attributes values. 

There are four Operators: 

MAX – calculates the maximum value for each row in the Report Grid.  This Opera-
tion cannot be selected with its corresponding attribute. 

MIN – calculates the minimum value for each row in the Report Grid. This Operation 
cannot be selected with its corresponding attribute. 

SUM – calculates the sum of all values in each row in the Report Grid. This is the only 
value that can be selected with its parent attribute, as it won’t create misleading results. 

17 



CAXperts 3D DataManager Quick Reference Guide 

Report Grid 

Report Grid 

The Report Grid Displays the Data that is selected by the two other components, the 
Tree Filter and the Report Attributes, in a standard table format. All columns shown 

h are similar to the Report Attribute 

are created from the selections in the Report Attributes.  

The Report Grid has three types of columns, whic
columns, the Path Column, the Operator Column and the Attribute Column. Each type 
of column is created by selecting a certain type of node in the Report Attributes.  

Path columns are shown in italics and if they have a value selected in the Tree Filters 
are not filterable. Filters can be applied to all other columns, and other functions such as 
sorting can be done in this view (see Grid Functions). 

Menus 

. 

  Main Me
The menu bar contains four drop-down menus as follows: 

• File – Open Project, Load/Save Views 

• Tools – Tree Manager (configure visibility of nodes in the tree), Settings 

• View – change the visibility of sections or toolbars 

and Toolbar 
There are a wide variety of toolbars and Menus in 3D DataManager The following will 
show a brief explanation of those and where to find them

nu 
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• Help – open this 3D DataManager help, update the licence or open the 
About box 

Toolbar Buttons 
The Toolbar allows faster access to the most important functions from the menu. 

 - Add a new view. 

  - Opens an existing view. 

  - Saves current view. 

  - Close the selected view. 

  - Export the report currently shown in the grid into a Microsoft Excel worksheet. 

  - Adds all attributes available to for the selected node. 

  - Removes all attributes below the selected node. 

  - Shows or Hides the Tree Filter. 

  - Shows or Hides the Report Attributes section. 

  - Shows or Hides the Report Grid. 

Context M

 
The View Menu is opened by right clicking on a View Tab. Possible operations 

enus 
There are four Context Menus, one for each section of 3D DataManager. The Menus 
are opened by right clicking on the associated item. All functions which are in each re-
lated menu can be found in the Menu bar and/or as a toolbar button. The different 
Menus are as follows: 

View Context Menu 

are as follows: 

 
Save View – Saves the current selected View. If the selected View has not been 

 before, opens the Save As dialog.  

Close View – Closes the selected View 

saved

Save View As – Saves the View under a certain file name. 

 Note:  There must be one View at all times, the last view cannot be 
closed. 
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 No  
For ea he Tree Filter a context menu can be opened by clicking the right 
mouse button. 

de Context Menu 
ch node in t

 

Rename – Renames the target Attribute Node. This is only visible with attribute nodes. 

ribute node name back to the original name. This is only 
visible with attribute nodes. 

Add attribute – Opens a popup menu listing all un-added attributes. Selecting one adds 

 selected node 

ected node representing an attribute. This is only 
visible with attribute nodes. 

Remove all attributes – Remove all attributes assigned under the selected node. . This 

Reset Rename – Sets the Att

it to the selected node. 

Add all attributes – Add all available attributes to the

Remove attribute – Removes the sel

is visible for all non-attribute nodes. 

  Note: Many context menu actions can be done with mouse actions such 
as Drag ‘n Drop or clicks 

 
enu is opened by right clicking the Report Attributes. 

Actions available are as follows: 

Attribute Context Menu 
The Attribute Context M

 
Select All – Selects all attribute nodes 

 – unselects all attribute nodes, including operator nodes. Unselect All

 Note: Unselecting will not affect the path nodes 

 
irst and primary way to filter. Right click on a 

Grid Context Menu 
enu shown below is the fThe Context m

cell in the grid to open it. 
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lumn filter to the current value in the selected grid cell. 

 

 – Excludes the current value in addition to the current 

and date/time col-

– These Filters are only available for numerical or 

filter for values between two values. 

Clear Colu  
resides. 

Clear All Filters – Resets all the filters in the grid. With the exception of filters set in 
rid

Filter by Selection – Sets the co

Exclude Selection – Sets the current column filter to exclude the value in the selected
grid cell. 

Append Exclude Selection
value(s) in the filter. This option is only enabled if the column has been filtered by ex-
clusion. 

Operational Filters – these filters are only available for numeric 
umns. The popup menu contains filters for ‘Greater than’, ‘Less than’, ‘Greater than or 
equal to’, and ‘Less than or equal to’, all are relative to the current selected grid cell. 

Append Operational filters 
date/time columns and if a previous operational filter has been set in the current column. 
This option enables the possibility to 

m  Filter – clears the current column filter in which the selected grid celln

path columns (see Report G ) 

e top of It is also possible to filter by selecting an item from the filter combo box at th
each column (see Filtering) 

 
indow Displays the current actions made in the 

The Log File rent computer under the 
3D DataManager folder. 

 
as tabs above the tree, attributes and grid 

(see below). 

Status bar and Log 
The status bar at the bottom of the W
program. Double clicking on it will open the log in which all actions and errors are 
saved.  

can be found under the Temp directory on the cur

5.2 Views 
Views are saved program states and are visible 
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Opening a View can be done in two ways, first, in the file menu, and secondly with the 
toolbar button ( ). Multiple Views can be opened at the same time. Each view is dis-
played as a tab a seen above. 

d a toolbar button(
Creating a new view can be done just as easily, this also has a menu item in the File 
menu, an ). 

Closing a View is done with the same methods as listed above and additionally with a 
context menu which is opened by right clicking a tab. The toolbar button icon is . 

Views also have the Save ( ), Save As ( ), and the Save All function, which can be 
found in one or more of the above mentioned Menu or toolbars. Saving writes changes 
to a view into a 3D DataManager View File (.cvf). After saving, this file can be opened 
with any Project. 

 Note: When opening a view, make sure, that the project used to open it 
has the required tasks and attributes. Otherwise 3D DataManager will not  open the view.

Openin
When 3D DataManager is opened for the first time, the open project dialog will appear. 
Select a Microsoft Access database file previously created with 3D DataManager Ex-

to load it. This project will be opened automatically on the fol-

g a Project 

tractor in the dialog 
lowing start. To open a different project, select the Open project… option from the File 
menu. 

 Note: It is possible to disable the automatic opening of the last project in 
the settings, under the tools menu. 

Cust izing th
Select Tree Manager…

om e Tree Filter 
 from the Tools menu. The following dialog box appears. 
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Expanding a task node will list all available attribute nodes. Select the required attrib-

utes by checking the preceding checkbox. Press the Add button ( ) to add the se-

lected nodes to the visible Report Attributes. Click on the  button to remove s
utes from the lef

Attributes w

e-
lected attrib t tree, after selecting them. Press the OK button to apply the 
changes. The Don’t Show ithout Values check box enables or disables at-
tributes under all Task Nodes which have no values in the database. 

 Note: A maximum of 50 attributes is the limit for one table (visible main 
node). 

 Note: Hovering over an attribute node will display the first 10 values of 
that attribute in a tooltip. 

The attributes newly added won’t be visible straight away. Open the context menu of the 
main node  
use the equ  
remove attr ove attribute from the context 
menu of the desired attribute node. Removing an attribute can also be done by dragging 

by clicking it with the right mouse button and select add all attributes or
ivalent toolbar button or a specific attribute from the list (Add attribute). To
ibutes for the purpose of clearness, select Rem

it to its task node. 
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Arranging V

Filter and

pose the d  
Nominal Pipe Diameters in the tree that are used for a specific Pipe Run follow the 
steps below: 

1. Grab an the 
Pipe Run node. 

2. Drop the node and expand the sub-
node.  

iews 
Arranging the views is the main purpose of 3D DataManager. In order to keep the proc-
ess simple, all actions can be done with a mouse. The following chapters will help set-
ting up each view part by part. All changes listed here are saved to a View file when 
saving the View. 

 Grouping functionality 
The Tree Filter can be used to filter and group the tree and so the report. For this pur-

esired nodes may be nested. If you want, for example, see the different

d drag the NPD node on 

Only the desired attribute nodes will be 
shown. 
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This process can be repeated recursively until the desired granularity has been reached. 

Column-a

own below. 

ttributes configuration 
For the currently selected node a report will be shown in the grid view of the Report 
section like sh
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chapter Filter and grouping functionality
This report can be expanded and grouped through further attributes as mentioned in 

 above. By default all available columns for the 
currently selected node are shown. Click the  button to show the attribute/co

ns to add or remove. 
lumn 

configuration section and select the colum
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With the buttons on top of the Attribute section all items can be checked ( ) or un-

checked ( ). 

Certain Attribute operations can be used, represented by the sub nodes in the Report 
Attributes. Currently MIN, MAX, SUM and COUNT are implemented. When en-
abled, a column per enabled function shows the result. 

 Note: MIN, MAX and SUM are only available for numeric attributes. 

 Note: The order of columns shown in “Attributes Section” is alphabetical 
and does not correspond to the order of columns shown in the grid. Add-
ing/Enabling one additional column will append the column at the end of the 
grid. 

Example: 

Grid view without functions 

 

Grid view with SUM enabled for Dry Weight column 
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Grid customizing and filter functions 
Within the grid, columns can be moved, sorted and filtered. 

Sorting 
Click the column header to sort the row ascending and once more in descending order. 
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Reordering 
Grab and drag the column you want to move and drop it to its new location (marked by 
a red arrow). 

 

 

 Filtering 

 

The NULL Value will filter for all empty values in the column, while the NOT-NULL 
does the opposite. 

It is also possible to filter by manually typing into the Filter field. Possible operators 
while manually filtering include ‘<’,’>’,’<=’,’>=’,’<>’,’*’, or ’%’. It is also possible to 
use the && (and) conjunction to place multiple filters for the same column. 

 Note: ‘*’ and ‘%’ can be used interchangeably, they can be used before 
text, after text or both but not in text i.e.  
Valid uses: S*, *S or *S*  
Non-Valid use: S*S 
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 Note: Filters are not case sensitive, with the exception of NULL and 
NOT-NULL. Thus is it possible to filter for the value null. 

 Note: One additional filter method is available only in 3D DataManager 
Pro (see Previewing Changes). 

 Resizing 
It is possible to resize each column in the Report Grid as seen below. There are two pos-
sibilities to do this. 

 

ssibility is to drag the space between columns to the right in order to in-
e left in order to decrease the size. There is also the possibility 

n to the largest value. This is done by simply double clicking the 
lumns. 

Closing

The first po
crease the size, and to th
to auto size each colum
space between the co

 and Saving 
Closing a view can be done by right clicking on the tab to open the context menu, then 
selection the close view option (see View Context Menu), or by using the tool bar but-
ton (see toolbars). 

If a View ha  
the view is 

If a view is s dialog will appear, if saved or closed. Also there 
is the possib s at once. This option can be found under the file menu. 

s been changed, or a View is newly created, a prompt will appear asking if
to be saved before closing. 

 newly created, the Save A
ility to save all view
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5.3 Repor
To export a rep

ting 
ort into an Excel spread sheet use the Toolbar button Export to Excel ( ).
ialog will appear. 

 
The following d

 

If you intend to use a template file, first press the File… or the new button to select an exist-
ing or create a new template. In case Use a template option has been checked, the current 

 in the Template File Path combo box will be used to format the data while exporting. 
It is recommended to create or edit a template using the New or Edit button which will in-
voke a Toolbar inside the excel application to help create and customize the current tem-

item

plate. 

 

The

dard Report – Apply the Header and Skip Lines setting and 

arker for the selected column in the cell 

upper border and the column markers 

 macro offers the following options/settings: 

• Create Stan
rebuild the sheet 

• Add Column – Insert a column m
currently selected 

• Header Lines – Insert the number of rows that should be between the 
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• Skip Lines B
tween each li

etween Rows – Inserts the given number in empty rows be-
ne(s) with data 

Additionally it is possible to insert pictures (i.e. your company logo), text and/or text for-
matting. 

Other important functions include the Multiline reports. By simply spreading the column 
marker across more than one line a multi lined repot is created. 

 

It is also possible to create Multipage reports. This is achieved by placing one or more col-
umn marker with in the header area. Placing for example #Area System# from a piping re-
port in to the header area, will create one sheet for each different type of Area System. 
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Close and save the template when you have finished. The Create Report dialog will be dis-
played again. Hit Create Report to generate the report. 

 

Above is the finished report with multiple Sheets. In this case each sheet represents a differ-
ent object type.  
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5.4 Example 
Creating Report Pipe list per Unit System 

1. Grab and drag the Unit System node and drop it on the Area System node.  

 

2. Expand the Area System nodes and select the desired Unit System.  
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3. Select the Attributes that should appear on the report (Pipe Run, Pipe Run NPD).  

 

35 



CAXperts 3D DataManager Quick Reference Guide 

4. Report preview in the Grid  

 

5. Save the View  

 

6. Export the report to Excel using a custom template or the default template 
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This Report is created using the default template. 
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6 
6.1 

3D DataManager Pro 
Grid Color Coding 
In order to show the different states of each value in the Report Grid, The cells of the 
grid are now color coded there are three colors as seen below: 

 

Blue represents a cell that has had its value changed. Grey cells are cells that cannot be 
edited, due to user rights, or belonging to read only values in SmartPlant 3D. White col-
ored cells represent unmodified changeable values. 

6.2 Changing a Value 
Editing a Value in the Grid is done very quickly with either the dropdown box (as seen 
below) or via direct input. A dropdown box will only appear if the cell is code listed. 
Columns that are code listed can only be changed using the dropdown. 
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Reset Changes 
In order to undo all changes from the Access Database all at once, the Reset Chan
function is available. This option can be found in the context menu of the grid. 

6.3 
ges 

 

By selecting this option, all changes made to the current task will be undone. 

 

6.4 Previewing Changes 
Additional features that 3D DataManager Pro offers are its preview columns. After 
changing a value, the Old Value Column will appear in front of the changed column. 
After writing changes to SmartPlant, the Update Status Column is added behind every 
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column that has been updated. As seen below, two different operators are visibl
Old Value and the Update Status Operators.  

The Old Value operator shows the original value of a changed Attribute next to the new 
attribute value. This is to ensure that prior to writing changes to SmartPlant 3D
known which changes have been made. 

e, the 

, it is 

 

3D DataManager Pro is the Update 
Values after the changes have been 
or this column is OK. This simply 

ith out a problem. The second possibility is 
een changed in the Report Grid has the 

The third possibility is an error message. This 
SmartPlant 3D databank. Amongst other 

s. The last of possible values is 

licable, by checking the reflective 

The other additional operator that is introduced in 
Status. The Update Status displays one of four 
written. The first of the possible shown values f
means that all changes have been recorded w
“Up to Date”. This states that the value that has b
same value as the SmartPlant 3D object. 
means that the value cannot be written to the 
things, this can be due to user rights or database problem
blank. This means no action has been taken. 

These columns can be added and removed where app
operator in the Report Attributes Tree. 

An additional filtering method is also available in 3D DataManager Pro. The Changed 
Values filter. When used, the filter shows only values that have been changed, making 

lant easier and more comfortable. This filter is 
the column has to have had changes done to it, 

 visible. If either of these conditions is 

previewing prior to writing to SmartP
only available on two conditions. First, 
and secondly, The Old Values Column has to be
not met, the Changed Values filter will have no effect.     
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6.5 Writing Changes 

 

Upon the selection of this option, the progress bar at the bottom right of the window 
will show the status of this process. Once this process is complete a message box will 
appear, stating the required time needed, and asking if the created database should be 
opened. 

All changes made in 3D DataManager Pro will also be changed in SmartPlant 3D. On 
top of that, the Update Status Operation will be available and checked for each column 
which had changes. This column shows the status of the update (see Previewing Chang-
es). After updating and depending on necessity, it may be necessary to export a new ac-
cess databank from SmartPlant 3D with 3D DataManager Extractor. 

 Note: The Write Changes Command processes each task separately. E.g. 
if the current selected task is piping, only the changes made in piping will be 
applied, 

 Note: In order to write changes, 3D DataManager needs to be executed 
on a computer with SmartPlant 3D installed. 

41 


	1 Introduction 
	1.1 General Conventions 
	1.2 Typefaces 
	Symbols 
	2 Installation 
	3 License 
	4 3D DataManager Extractor 
	4.1 Loading and Setting up a SmartPlant 3D Plant 
	4.2 Create SmartPlant Review session 
	4.3 Configure Search Filters 
	4.4 Configure Columns/Attributes 
	4.5 Configure Units of Measure 
	4.6 Result database 
	Piping Catalog 
	Piping 
	Equipment 
	Structural 
	HVAC 
	Electrical 
	Plant 

	4.7 Batch Mode 

	5  3D DataManager Reporter 
	5.1 A Brief Overview 
	Elements 
	Tree Filter 
	Report Attributes
	Report Grid

	Menus and Toolbar 
	  Main Menu 
	Toolbar Buttons 
	Context Menus 
	View Context Menu 
	Node Context Menu 
	Attribute Context Menu 
	Grid Context Menu 
	Status bar and Log 



	5.2 Views 
	Opening a Project 
	Customizing the Tree Filter 
	Arranging Views 
	Filter and Grouping functionality 
	Column-attributes configuration 
	Grid customizing and filter functions 
	Sorting 
	Reordering 
	Filtering 
	Resizing 


	Closing and Saving 

	5.3 Reporting 
	5.4 Example 

	6 3D DataManager Pro 
	6.1 Grid Color Coding 
	6.2 Changing a Value 
	6.3 Reset Changes 
	6.4 Previewing Changes 
	6.5 Writing Changes 





